
GUI Information and Shortcuts

This appendix describes the Cisco Transport Planner views, menus, tools, and shortcuts options. For more
information about Cisco Transport Planner, refer to Introduction.

• Manage the Cisco Transport Planner Window, page 1

• Site Icons, page 21

• Demand Editor Icons, page 23

Manage the Cisco Transport Planner Window
The Cisco Transport Planner window provides a menu bar, toolbar, a Project Explorer pane, a Properties pane,
an Analyzer pane, and a Task Pane to allow you to manage a network design as shown in the following figure.
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The Mgmt Tree tab displays the networks that you have created for a project. The NtVw Net# tab displays
the sites for a network (identified by the Net# on the tab).

Figure 1: Cisco Transport Planner Window with Network Tree
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Menu and Toolbar Options
The Cisco Transport Planner windowmenu bar and toolbar provide primary Cisco Transport Planner functions.
The below table shows the actions that are available from the menu and toolbar.
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Table 1: Menu and Toolbar Options

DescriptionToolbarMenu OptionMenu

Creates a new Cisco
Transport Planner project.
See theCreating a Project.

NewFile

Opens an existing Cisco
Transport Planner project.
See theOpening a Project.

Open

Imports node parameters
from a network.

Import Network

Closes the current project
without closing the Cisco
Transport Planner session.
If you have not saved the
current project, Cisco
Transport Planner will
prompt you to save before
closing. See the Closing
a Project.

Close

Saves the current project.
See the Closing a Project.

Save

Allows you to save the
current project with a new
file name. See the Saving
a Project.

Save As

Clears the file history
from Cisco Transport
Planner. Cisco Transport
Planner maintains a list of
the last ten open projects
in the File menu.

—Clear History

Exits the Cisco Transport
Planner software.

—Exit
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DescriptionToolbarMenu OptionMenu

Changes the Cisco
Transport Planner display
to the user default layout.
Cisco Transport Planner
allows you to define the
default value for Platform
Options, Project Options,
and General Options. The
defined value are used as
default for each new
created project. See
theSetting Cisco
Transport Planner
Options.

—My Default LayoutView

Returns the Cisco
Transport Planner display
to the system default
layout.

—Default Layout

Displays the commands
available for the selected
entity (network, site, duct,
etc.).

—Task Pane

Displays the Project
Explorer pane, which
includes folders for
project notes, networks,
sites, fibers, traffic
demand groups, subnets,
maintenance centers,
restricted equipment list,
and reports. Clicking the
plus (+) sign by each
folder expands the folder.
Clicking the minus (–)
sign by each folder hides
the folder. contents. You
can also right-click a
folder and chooseExpand
from the shortcut menu to
show folder contents. The
default location of the
Project Explorer pane is
the upper left section of
the Cisco Transport
Planner window.

—Project Explorer
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DescriptionToolbarMenu OptionMenu

Properties Displays the Properties
pane, which shows
parameter settings for the
selected entity in the
Project Explorer pane,
Mgmt Tree tab, or NtVw
Net# tab. The default
location of the Properties
pane is the lower left
section of the Cisco
Transport Planner
window.

—

Displays the Analyzer
Messages pane at the
bottom of the Cisco
Transport Planner
window. The Analyzer
Messages pane displays
any error messages that
occur during network
analysis.

—Analyzer Messages

Displays Any-to-Any
Finalization report at the
bottom of the Cisco
Transport Planner
window. TheAny-to-Any
Finalization report pane
displays the demands that
are finalized in the
network.

—A2A Finalized Circuits
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DescriptionToolbarMenu OptionMenu

Opens the Options
Explorer dialog box,
where you can change the
user default settings. See
theSetting Cisco
Transport Planner
Options.

—OptionsTools

Opens the PartsTreePanel
dialog box, where you can
view the list of available
parts for each release. See
the Setting the Default
Project Values.

DB Parts Mgmt

Opens the Price Manager
dialog box, where you can
view maintenance
contracts and add price
databases. See the
Managing the Price List.

—Price List Mgmt

Opens the Export dialog
box, which allows you to
export user options, price
lists, maintenance
contracts, and parts
database files. See
theExporting User
Options, Price Lists or
Alien Definitions.

—Export

Opens the Import dialog
box, which allows you to
import user options, price
lists, maintenance
contracts, and parts
database files. See the
Importing User Options,
Price Lists or Alien
Definitions.

—Import

Opens the Import dialog
box, which allows you to
import Layer 2 network
designs using the Cisco
Carrier Packet Transport
system.

—Import from Sherpa
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DescriptionToolbarMenu OptionMenu

Deletes the CTP cache on
restart.

—Delete Cache

Opens the Cisco
Transport Planner online
help.

—ManualHelp

Opens the Tip of the Day
dialog box, which
provides helpful hints
about using Cisco
Transport Planner. Click
the Next button to view
the next tip and the Back
button to view a previous
tip. Check Show Tips on
Startup to display the Tip
of the Day dialog box
when you launch Cisco
Transport Planner.

—Tips of the Day

Displays Cisco Transport
Planner version
information.

—About

Network Toolbar

Opens the Network
Creationwizardwhen you
click this icon and then
click in the Cisco
Transport Planner
window. See theCreating
a Project.

Create a new subnet—

Opens the Site Creation
wizard when you click
this icon and then click in
the Cisco Transport
Planner window. See the
Adding Sites.

Create a new site—

Allows you to create a
new duct between sites.
See the Adding Fiber
Spans.

Create a new duct—
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DescriptionToolbarMenu OptionMenu

Opens the Point to Point
Demand Creation wizard
when you click this icon
and then click two sites.
See theUnderstanding
Contentionless
Functionality.

Create a new P2P demand—

Opens the P-Ring
Creation wizard. See the
Creating a Protected Ring
Demand.

Create a new P-ring
demand

—

Opens Finalize
Any-to-Any Traffic
window.

Finalize Any-to-Any
traffic

—

Displays the Any-to-Any
demands that are finalized
in the network

Toggle the filter for
Any-to-Any finalized
traffic

—

Opens a TDM creation
wizard. See the Creating
TDM Aggregated
Demands.

Create a new TDM
Aggregated demand

—

A new tool that provides
a Card View and Mesh
View for analyzed
networks.

Connection
Viewer lists only
the Line sides in
the drop-down
list.

Note

Connection Viewer—

Opens a Ethernet creation
wizard. See the Creating
Ethernet Aggregated
Demands.

Create a new Ethernet
Aggregated demand

—
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DescriptionToolbarMenu OptionMenu

Displays the CTP GUI
Options dialog box where
the wavelength options
can be set. The
wavelength information
can be displayed in nm,
as a channel number or
both.

Set various GUI options—

Hides or displays duct
information (duct name,
EOL), amplifier forcing,
and circuits on the
network map in the
Network tab.

Hide/show Network
Details

—

Hides or displays
wavelength usage
percentage in color on the
network map in the
Network tab.

– To display the
wavelength usage in
color, clickWavelength
Usage Information in the
network view. This option
is enabled only after
network analysis is
complete.

– To highlight ducts that
have selected
wavelengths, choose the
requiredwavelength from
the adjacent drop-down
list and then click
Wavelength Usage
Information. The default
option is Auto, where all
the wavelengths in the
duct are selected.

Wavelength usage
information

—

Zooms in on the NtVw
Net# tab.

Zoom in—
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DescriptionToolbarMenu OptionMenu

Zoom out from the NtVw
Net# tab.

Zoom out—

Returns the NtVw Net#
tab to normal viewing
(1:1).

Normal viewing—

Resizes the view so that
all sites fit inside the
NtVw Net# tab window.

Fit to window—

Saves a JPEG of the
network design. See the
Creating a JPEG of the
Network Design.

Save network view image—

Analyzes the selected
network. See the
Analyzing the Network.

Analyze Network—

Puts the selected
Design-Analyzed network
back into the designmode
for further changes. See
the Analyzing the
Network.

Enter design mode—

Creates a copy of the
selectedDesign-Analyzed
network in the Upgrade
state. See the Creating an
Upgrade Network.

Put current network in
upgrade mode

—

Deletes the selected
network. See theDeleting
a Network.

Delete current network—

Copies the selected
network. See theCreating
a Copy of the Network.

Copy current network—
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DescriptionToolbarMenu OptionMenu

Creates a copy of the
selectedDesign-Analyzed
network in the Install
state. See the Creating a
Network in the Install
State.

Put current network in
install mode

—

Copies the selected
network in the Design
state. See theCreating a
Copy of the Network in
Design State.

Copy & Go back to
Design Mode

—

Opens the Reports Diff
dialog box, which allows
you to create a report that
shows the differences
between networks.

Reports Diff—

Deletes unloaded
networks from memory.

Run the Garbage
Collector

—

Cisco Transport Planner Panes
Cisco Transport Planner provides four panes that help you manage a network design: Project Explorer,
Properties, Analysis, and Tasks Pane.

Project Explorer Pane
The Project Explorer pane provides a management tree for the entire project. Each network appears as a folder
that contains the sites, fibers, traffic groups, subnets, maintenance centers, restricted equipment lists, and
reports for that network. If you have made changes to a network design, that network folder and the changed
item folder appear in blue italics in the pane.

By default, the Project Explorer pane is located in the upper-left section of the Cisco Transport Planner window.
The below table shows the actions that are available from the Project Explorer toolbar.

Table 2: Project Explorer Toolbar Options

DescriptionToolbar

Displays the Project Explorer as a single pane.
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DescriptionToolbar

Displays the Project Explorer as split panes. The
upper pane contains the main project tree; the lower
pane shows only the folders for the network that is
selected in the upper pane.

Auto scrolls to the selected object in the Project
Explorer tree. For example, if you click on a site in
the NtViewNet# tab but it is not in view in the Project
Explorer tree, Cisco Transport Planner will
automatically scroll the Project Explorer pane until
the selected site is in view.

Allows selection of multiple folders or icons (or both)
in the Project Explorer pane.

Moves backward through the list of previously
selected items in the Project Explorer pane.

Moves forward through the list of previously selected
items in the Project Explorer pane.

Moves (undocks) the Project Explorer pane from the
default location in the upper left corner so that you
canmove it around your desktop area as an individual
window.

Moves the Project Explorer pane back to the default
location.

Hides the Project Explorer pane. To view again, move
the mouse over the Prop tab that appears in the upper
left corner of the Cisco Transport Planner window.

When in hidden mode, reopens the Project Explorer
pane in the default location.

Closes the Project Explorer pane. To reopen, choose
Project Explorer from the View menu.
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Properties Pane
The Properties pane shows all of the parameters set for a selected item (either in the Project Explorer pane,
the NetworkMgmt Tree tab, or the NtVwNet# tab). Many items are editable in the Properties pane. By default,
the Properties pane is located in the lower-left section of the Cisco Transport Planner window.

The below table shows the actions that are available from the Properties Pane toolbar.

Table 3: Properties Pane Toolbar Options

DescriptionToolbar

Categorizes the properties by type.

Organizes the properties in alphabetical order.

Shows or hides the description area at the bottom of
the Properties pane.

Expands the property categories (if collapsed).

Collapses the property categories (if expanded).

Moves (undocks) the Properties pane from the default
location in the lower left corner so that you can move
it around your desktop area as an individual window.

Moves the Properties pane back to the default
location.

Hides the Property pane. To view again, move the
mouse over the Prop tab that appears in the upper left
corner of the Cisco Transport Planner window.

When in hidden mode, reopens the Properties pane
so that it appears in the default location.
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DescriptionToolbar

Closes the Properties Pane. To reopen, choose
Properties from the View menu.

Analyzer Pane
The Analyzer tab at the bottom of the Cisco Transport Planner window appears after you have analyzed a
network design. Clicking the Analyzer tab opens the Analyzer pane. The below table shows the actions that
are available from the Analyzer pane.

Table 4: Analyzer Toolbar Options

DescriptionToolbar

Moves down through the Analyzer messages.

Moves up through the Analyzer messages.

Opens the Apply Filters dialog box, which allows
you to filter the messages to show or hide Exceptions,
Errors, Warnings, and/or Info.

Expands the Analyzer message categories (if
collapsed).

Collapses the Analyzer message categories (if
expanded).

Moves (undocks) the Analyzer pane from the default
location in the lower left corner so that you can move
it around your desktop area as an individual window.

Moves the Analyzer pane back to the default location.
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DescriptionToolbar

Hides the Analyzer pane. To view again, move the
mouse over the Analyzer tab that appears in the
bottom of the Cisco Transport Planner window.

Opens the Analyzer pane so that it remains open in
the bottom section of the Cisco Transport Planner
window.

Closes the Analyzer pane. To reopen, choose

Analyzer

messagesfrom the View menu.

Tasks Pane
The Tasks Pane lists the available commands and reports for a selected item. The commands change based
on the selected item. For example, a selected site will have different commands available than a selected fiber
span. By default, the Tasks Pane is located in the upper right section of the Cisco Transport Planner window.
The below table shows the actions that are available from the Tasks Pane toolbar.

Table 5: Tasks Pane Toolbar Options

DescriptionToolbar

Moves (undocks) the Tasks Pane from the default
location in the lower left corner so that you can move
it around your desktop area as an individual window.

Moves the Tasks Pane back to the default location.

Hides the Tasks Pane. To view again, move themouse
over the Tasks tab that appears in the upper right
corner of the Cisco Transport Planner window.

When in hidden mode, reopens the Tasks Pane so that
it appears in the default location.

Closes the Tasks Pane. To reopen, choose

Tasks

Pane from the View menu.
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Shortcuts
Cisco Transport Planner provides the following mouse shortcuts:

• Double-clicking a network icon in the Network Mgmt Tree tab opens the NtVw Net# tab, which shows
the sites for that network.

• Right-clicking a report table column displays a shortcut menu that allows you to view or hide the columns
in a report.

• Right-clicking an item in the Network Mgmt Tree tab or NtVw Net# tabs opens a shortcut menu that
allows you to choose actions to perform on the selected item. The shortcut menu options differ based
on the item selected and the network state. (Many commands are not available until a network is analyzed.)
The following table lists the shortcut menu actions that are available for each item.

• Right-clicking on multiple items in the Project Explorer pane opens a shortcut menu that allows you to
choose actions to perform on multiple items. The shortcut menu options are Delete, Unlock, Unlock
Pay As You Grow Bundles, and Insert Site. The Unlock Pay As You Grow Bundles option is available
only for sites and the Insert Site option is available only for ducts.

Table 6: Shortcut Menu Actions

DescriptionToolbar

• Unload/Load—Unloads or loads the network.
See the Loading and Unloading Networks.

• Edit Note—Allows you to create a note for that
item. See the Adding Notes to a Project.

Networks in the following states: Design, Install, and
Upgrade

• Delete—Removes the network from the project.
See theDeleting a Network .

• Copy—Creates a copy of the network. See the
Creating a Copy of the Network.

• Upgrade to Design— Copies the selected
network in the Design state. See theCreating a
Copy of the Network in Design State .

• Arrange Sites—Allows you to rearrange sites
in the Cisco TransportPlanner window. See the
Arranging Sites.

• Forcing Manager—Unlocks individual units in
multiple sites/ducts. See the Forcing Manager.

Networks in the following states: Design, Install, and
Upgrade
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DescriptionToolbar

• Unload/Load—Unloads or loads the network.
See the Loading and Unloading Networks.

• Edit Note—Allows you to create a note for that
item. See the Adding Notes to a Project.

• Install—Creates a copy of the network in the
Install state. See the Creating a Network in the
Install State.

• Open Site Functional View—Opens the site
functional view. See the Viewing the Site
Functional View.

• UnSplit Node—Unsplits the node on the site.
To split again, right-click on the site and select
Split Node.

• Delete—Removes the network from the project.
See the Deleting a Network.

• Upgrade—Creates a copy of the network in the
Upgrade state. See theCreating an Upgrade
Network .

• Copy—Creates a copy of the network. See the
Creating a Copy of the Network.

• Layout—Opens the Layout tab. See the Viewing
the Layout of Single Site.

• Internal Connections—Opens the Internal
Connections tab. See the Viewing Internal
Connections.

• Optical Results—Opens the Optical Results tab.
See the Viewing Optical Results.

•Wavelength Routing—Opens the Wavelength
Routing tab. See the Viewing Wavelength
Routing.

• Bill of Material—Opens the Bill of Materials
tab. See the Viewing a Network BoM.

Analyzed networks
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DescriptionToolbar

• Installation—Opens a submenu with the
following options:

◦NE Update—Creates a configuration file
for each site in the network See the Saving
the NE Update File.

◦Installation Parameters—Opens the
Installation Parameters tab. See the
Viewing the Installation Parameters.

• Arrange Sites—Allows you to rearrange sites
in the Cisco Transport Planner window. See the
Arranging Sites.

Analyzed networks
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DescriptionToolbar

Sites
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DescriptionToolbar

• Edit—Allows you to edit the demand. See the
Editing a Point-to-Point Demand, Editing a
P-RingDemand, or Editing a ROADMDemand
.

• Edit Note—Allows you to create a note for that
item. See the Adding Notes to a Project.

• Unlock—Unlocks the site. See the Unlocking
Parameters in the Network Design.

• Delete—Removes the site from the project. See
the Deleting Sites.
If the network is analyzed, the following actions
are also available:

• Layout—Opens the Layout tab. See the Viewing
the Layout of Single Site.

• Internal Connections—Opens the Internal
Connections tab. See the Viewing Internal
Connections.

• Optical Results—Opens the Optical Results tab.
See the Viewing Optical Results.

•Wavelength Routing—Opens the Wavelength
Routing tab. See the Viewing Wavelength
Routing.

• Bill of Material—Opens the Bill of Materials
tab. See the Viewing a Network BoM.

• Installation—Opens a submenu with the
following options:

◦NE Update—Creates a configuration file
for each site in the network. See the
Saving the NE Update File.

◦Installation Parameters—Opens the
Installation Parameters tab. See the
Viewing the Installation Parameters.

• Provision Node—Exports the NE UPdate
Configuration file to the node. Opens the Node
Login window. See the Bidirectional
Communication with the Network Element.

• Unlock Pay As You Grow
Bundles—Recalculates the PAYG bundles for
the site when the network is analyzed. See the
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DescriptionToolbar

Unlock Pay As You Grow Bundles.

• Open Site Functional View—Opens the site
functional view. See the Viewing the Site
Functional View.

• Unlock—Unlocks the site. See the Unlocking
Parameters in the Network Design.

• Forcing Manager—Unlocks individual units in
multiple sites/ducts. See the Forcing Manager.

Sites

• Edit Note—Allows you to create a note for that
item. See the Adding Notes to a Project.
If the network is analyzed, the Unlock command
is also available. See the Unlocking Parameters
in the Network Design.

Fiber spans

• Edit Note—Allows you to create a note for that
item. See the Adding Notes to a Project.

• Edit—Allows you to edit the demand. See the
Editing a Point-to-Point Demand,Editing a
P-RingDemand, or Editing aROADMDemand.

• Delete—Removes the demand from the project.
See the Deleting a Traffic Demand.

• Add/Remove Site—Allows to add or remove
sites from P-Ring, Ethernet Aggregated, and
TDM Aggregated demands.
If the network is analyzed, the Unlock command
is also available. See the Unlocking Parameters
in the Network Design.

Traffic demands

Site Icons
A site icon indicates the functionality of site. The below table shows the site icons.

Cisco Transport Planner DWDM Operations Guide, Software Release 10.6    
21

GUI Information and Shortcuts
Site Icons

454mp_opsguide_chapter_01.pdf#unique_78
454mp_opsguide_chapter_010.pdf#unique_125
454mp_opsguide_chapter_010.pdf#unique_125
454mp_opsguide_chapter_010.pdf#unique_54
454mp_opsguide_chapter_010.pdf#unique_54
454mp_opsguide_chapter_010.pdf#unique_55
454mp_opsguide_chapter_010.pdf#unique_83
454mp_opsguide_chapter_010.pdf#unique_54
454mp_opsguide_chapter_010.pdf#unique_54
454mp_opsguide_chapter_010.pdf#unique_83
454mp_opsguide_chapter_0100.pdf#unique_113
454mp_opsguide_chapter_0100.pdf#unique_114
454mp_opsguide_chapter_0100.pdf#unique_114
454mp_opsguide_chapter_0100.pdf#unique_170
454mp_opsguide_chapter_0100.pdf#unique_183
454mp_opsguide_chapter_010.pdf#unique_54
454mp_opsguide_chapter_010.pdf#unique_54


Table 7: Site Icons

DescriptionSite IconSite Name

Indicates that this site has add/drop
capability. Only point-to-point and
P-ring circuits can be
added/dropped at this site.

Add/Drop

Indicates that this site uses
wavelength selective switch cards
to control the generated tilt and
extend unregenerated distances.
The site is realized as an ROADM
site without demultiplexer cards.

Gain equalizer

Indicates that this site is equipped
with filters for adding and dropping
all the channels (on both West and
East sides). All express paths are
open in hub configurations.

Hub

Indicates that any add/drop traffic
is prevented at this site.

Line amplifier

Indicates that site is designated for
network communication, providing
the possibility to access the optical
service channel (OSC) for
management of the MultiService
Transport platform (MSTP)
network. By default, no amplifiers
are included in this site. However,
if Cisco Transport Planner
determines that an amplifier is
required in the network, it can
automatically place it at this
location. Cisco Transport Planner
allows you to set (force)
preamplifier and booster amplifiers
for each direction on a OSC Site
node.

OSC site

Indicates that no equipment will be
located at this site.

Pass Through
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DescriptionSite IconSite Name

Indicates that this site supports
Any-to-Any and also Fixed
(point-to-point and P-ring) traffic
types.

R-OADM

Indicates a PSM site with Aw
representing the working path and
Ap representing the protected path.

PSM

Indicates a terminal site.Terminal

Indicates a multi degree OXC site.OXC

Indicates a multi degree OIC siteOIC

Demand Editor Icons
The below table shows the demand editor icons.

Table 8: Demand Editor Icons

DescriptionIcons

Expands the services of a demand (if collapsed).

Collapses the services of a demand (if expanded).

Creates a new service.
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DescriptionIcons

Deletes an existing service.

Selects siblings at the same level.

Selects all siblings of the same type.

Opens the path constraints editor.

Opens the regeneration editor.

Opens Optical Bypass editor.
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